
GoldenEye Setup Editor 2.1 Tutorial 

 

by SubDrag 

Importing all New Levels – GoldenEye and Perfect Dark 

Steps: 

1)Creating your level in a modeler 

2) Create a project folder 

3) Start a new level that you will work with 

4) Adding Textures to ROM and Obj Conversion 

5) Clipping 

6) Portals 

7) Visibility 

8) Lighting (Perfect Dark only) 

9) Setup File 

10) Project Basics 

11) Image Editor 

12) Checklist when level doesn’t load 

Prerequisites: 

1) Creating your level in a modeler 

This tutorial will not cover how to do actual modeling in an editor such as DeleD, Blender, Sketchup, or 

even the Hammer editor, but all of those have shown success in creating files to import into the editor.  

 Background File 

i. Clipping, background, and portal files can be in the same model (obj and mtl) 

files, but do not have to be.   

ii. Textures for your file must be 256 Color (8-bit) paletted bitmaps, and the 

dimensions must be no larger than 32 x 64 or 64 x 32, and be a factor of 8.  So 

32 x 32 is valid, 64 x 32, 32 x 64, or smaller, etc.  64 x 64 and 64 x 48 are NOT 

valid.  If you would like the texture to be transparent (black is see-thru and not 

displayed), you must call that particular bitmap 

[myBitmapName]Transparent.bmp (where [myBitmapName] is a name for your 

texture).  This indicates to the editor that the bitmap should be transparent on 

import.  If you need a texture both transparent, and non-transparent, you need 

two copies thus, one called [myBitmapName]Transparent.bmp, and the other 

just [myBitmapName] (or any other name).  Texture filenames should not 

contain spaces except for the original textures which may contain spaces since 

they already do. 

iii. If desiring to use original GoldenEye or Perfect Dark textures textures, the exact 

original names must be copied into your modeling folder from romimagesfull 



(GoldenEye) or pdromimagesfull (Perfect Dark) used, and the original name 

maintained.  An example filename from GoldenEye is 8F9022Other8012D.bmp.  

No textures will be added for these, and the originals will be used.   

iv. Model groups are used to designate rooms in GoldenEye.  Rooms are used to 

not load the entire level at all times.  The more rooms present, the faster 

potentially the level will run, however, the more complicated it is to clip and 

portal.  Generally, rooms should be designated where two openings intersect, 

such as windows, hallway entrance, exits, etc.  Check out Rare’s level for some 

help if need be.  Portals will go between the two rooms to see between the two 

rooms, so a flat edge is required.   

 

The format is RoomXX, where XX is a hex room, starting at 01.  There must be 

no gaps in rooms numbers, so you cannot have Room01, Room02, then 

Room04, as the game will cut off and only think there are 2 rooms.  The editor 

should warn you when this happens as a check though.  GoldenEye has a 

maximum of 0x96 (150 rooms), while PD has 0x110 (272 rooms).  For PD, 

RoomXXX can also be used. 

 

So your groups should be named for rooms, starting at hex 01: 

 

Room01 

Room02 

… 

Room09 

Room0A 

Room0B 

Room0C 

Room0D 

Room0E 

Room0F 

Room10 (Pattern repeats) 

Room11 

… 

Room96 (GoldenEye Max # Rooms) 

Room97 (Perfect Dark Only allowed) 

… 

RoomA0 

RoomA1 

… 

Room10F (Perfect Dark Max # Rooms) 

 



Multiple groups with the RoomXX designation will be lumped together in the 

editor, so if the modeler outputs strange group names, as long as it contains the 

RoomXX for each Room group, it will be imported properly.   

 

As a Side note, if you choose to do one room only, it has a maximum number of 

2,184 triangles, and will most likely cause severe lag.  The rooms option is 

preferable.  If using one room, no portals should be used.   

 

v. Primary versus Secondary 

 

Each room in GoldenEye and Perfect Dark have primary and secondary indices.  

Primary indices can be shot and the shots hit the surface, while secondary 

indices bullets pass right through them.  Generally, any texture with a 

transparent (black color see through) texture should be in secondary indices.  

Secondary indices are always rendered after primary indices. 

 

The default import for all Rooms groups is primary.  If unspecified by a group 

(no primary or secondary in group name), all room data will be primary indices.   

 

If desiring to use both primary and secondary, instead of naming the group 

RoomXX, two groups can exist, RoomXX primary and RoomXX secondary.  

Primary groups for rooms MUST exist, while secondary is optional.  Also note 

that the words primary and secondary ARE case sensitive. 

 

For example, for Room 1, there would be a group named Room01 primary, 

while the secondary indices would be in a group called Room01 secondary.  

Followed by Room02 primary and Room02 secondary, etc.   

 

If using transparency, due to the way GoldenEye renders, the transparent 

textured triangle must be last in the room.  It may be difficult to do this in 

current modellers, so it is recommended transparent textures be in secondary 

indices so that it is drawn after primary indices and looks correct. 

 

Another important fact is that the way it’s configured, primary indices only show 

the front face, while secondary indices show from both the front and back. 

 

vi. Export to .obj format 

 

Using your modeler, export to .obj format.   

 

Two files should be generated: 

A .obj file and a .mtl file. 



 

The .obj file contains the groupings of triangles, contains vertices, vertice 

texture positions, and then uses materials to draw triangles, and references 

materials in the .mtl file by the usemtl line, such as usemtl myMaterial.   

 

In the .mtl file, each new material is defined by the newmtl line, such as newmtl 

myMaterial.  The usemtl line from the .obj file should map exactly to a name in 

the .mtl file.  It is not necessarily the bitmap name used.   

 

For a material, the following properties are used by the editor, the rest are 

ignored: 

 

Kd – Coloring (colored shading) for the triangle 

Format is Kd float float float 

Example: Kd 0.000000 0.137255 0.827451 

 

d (or Tr) – Alpha of triangle, how see through the whole triangle is.  Tr and d are 

interchangeable here. 

*NOTE: ALPHA IS UNSUPPORTED, but may be later. 

Format is d float (or Tr float) 

Example is: d 0.620000 (or Tr 0.620000) 

 

map_Kd – Texture to use for the triangle.  All triangles must use a texture.  The 

texture must not contain any windows path and cannot contain “s, and must be 

in the same directory as .mtl and .obj file.  For example, 

C:\Windows\Temp\A.bmp is BAD, but A.bmp is GOOD.  Some modellers spit out 

files with “s or full paths, and these must be manually removed.   

Format: map_Kd TEXTUREBITMAPNAME 

Example is: map_Kd Texture.bmp 

 

 Clipping File 

i. Clipping is used to provide the set of areas and boundaries that a player can 

walk on.   

ii. Clipping can be done in the editor (and capably), so skip this step if you desire to 

perform them in the editor itself. 

iii. Clipping, background, and portal files can be in the same model (obj and mtl) 

files, but do not have to be.   

iv. Model groups are used to designate clip rooms in GoldenEye.  Clipping room 

numbers must correspond exactly to the background rooms, although not all 

rooms require clipping (for example, if room is in air and not walked on). 

v. The format is ClipXX (GE) and ClipXXX (PD) for the group, where XX is the same 

room number in hex as in the background.  Note than in the past, the format 



was RoomXX (same as background files), and had to be separate obj/mtl files 

from the background obj/mtl.  Although the old format is still supported as 

separate obj files, ClipXX is recommended. 

vi. For GoldenEye, floors must be the only triangles that should be in the clip 

groups, and the absence of clipping tile means you cannot walk there, while 

Perfect Dark, floors are where a player can walk, while walls provide a way to 

block players movement. 

vii. Export to .obj format 

 

Using your modeler, export to .obj format.   

 

Two files should be generated: 

A .obj file and a .mtl file.  Note that the file can be the same file as with 

background, as long as using RoomXX and ClipXX groups. 

 

For a material, the following properties are used by the editor, the rest are 

ignored: 

 

Kd – Coloring (colored shading) for the clipping triangle 

Format is Kd float float float 

Example: Kd 0.000000 0.137255 0.827451 

 

 Portal File 

i. Portals are a way to connect two rooms, so that you can see from one room to 

the other.   

ii. Portals can be done in the editor, so skip this step if you desire to perform them 

in the editor itself. 

iii. Clipping, background, and portal files can be in the same model (obj and mtl) 

files, but do not have to be.   

iv. All portals must be rectangles, no other amount of points is supported. 

The format is Portal_XX_YY (or PD Portal_XXX_YYY is supported if >= 0x100 

rooms) for each portal, where XX is the first room, and YY is the connected 

room. 

Example Portal_05_01 

v. Of special note, if more than one of the same combination of XX and YY exist 

(two of the same portal connections), subsequent portals of the same group 

combination need to have unique names so that the modeler does not combine 

group data. 

Example: Portal_05_01 and Portal_05_01 V2 and Portal_05_01 V3 

vi. Export to .obj format 

 

Using your modeler, export to .obj format.    The material file is not used. 



 

 Path Presets File 

i. Path presets are used to create the method by which guards can navigate a 

level.  It is not required for GoldenEye multiplayer levels, but is required for all 

solo levels and for multiplayer levels in Perfect Dark (for simulants to move 

around).   

ii. Path Presets can be done in the editor (and capably), so skip this step if you 

desire to perform them in the editor itself. 

iii. Your obj exporter and modeler must support the concept of lines.  So far, only 

Sketchup has been confirmed to support lines.   

iv. Model a set of lines, connecting where simulants should walk.  The more sets of 

line connections, the better the simulants/guards navigate and faster the level 

runs.  At a minimum lines should be drawn to connect every room and around 

obstacles.  If simulants are not intended for a particular room, do not connect 

that room to the whole network. 

v. Using your modeler, export to .obj format.    The material file is not used. 

 Presets/Pads File  

i. If desired to precisely place 00 presets (or basic pads) in PD, a presets pads file 

can be created.   

ii. All vertices are imported as a 00 preset/pad.  All other commands and the 

material file are ignored. 

iii. Using your modeler, export to .obj format.    The material file is not used. 

2) Create a project folder 

i. Under C:\Program Files\GEEdit2\ create a subfolder for your project.  Copy the 

.obj and mtl file and all bitmaps used. 

 

3) Start a new level that you will work with 

i. Switch to the game you want to edit (GoldenEye or Perfect Dark).  Tools -> 

Switch Editor Game. 

ii. Do File->New and choose which level you want to edit.  For GoldenEye, you also 

have to specify a level scale, in almost all circumstances, set it to 1.0.  If you 

model your level at half the size, a scale of .5 will make it appear at full size in-

game.  Perfect Dark has no scaling.  Use a solo level if you’re importing solo, or 

multi if a multi.  Then hit OK.   

 

List of setup names vs levels: 

 

GoldenEye: 

Ump_setupameZ.bin Library 

Ump_setuparchZ.bin Archives 

Ump_setuparkZ.bin Facility 



Ump_setupashZ.bin Stack 

Ump_setupcaveZ.bin Caverns 

Ump_setupcradZ.bin Cradle 

Ump_setupcrypZ.bin Egyptian 

Ump_setupdishZ.bin Temple 

Ump_setupimpZ.bin Basement 

Ump_setupoatZ.bin Caves 

Ump_setuprefZ.bin Complex 

Ump_setupsevbZ.bin Bunker 2 

Ump_setupstatueZ.bin Statue 

UsetuparchZ.bin Archives 

UsetuparkZ.bin Facility 

UsetupaztZ.bin Aztec 

UsetupcaveZ.bin Caverns 

UsetupcontrolZ.bin Control 

UsetupcradZ.bin Cradle 

UsetupcrypZ.bin Egyptian 

UsetupdamZ.bin Dam 

UsetupdepoZ.bin Depot 

UsetupdestZ.bin Frigate 

UsetupjunZ.bin Jungle 

UsetuplenZ.bin Cuba 

UsetuppeteZ.bin Streets 

UsetuprunZ.bin Runway 

UsetupsevbunkerZ.bin Bunker 1 

UsetupsevbZ.bin Bunker 2 

UsetupsevxbZ.bin Surface 2 

UsetupsevxZ.bin Surface 1 

UsetupsiloZ.bin Silo 

UsetupstatueZ.bin Statue 

UsetuptraZ.bin Train 

UsetupcatZ.bin Zoinkity's Citadel 

 

Perfect Dark: 

Setup filename for editor Real Level 

Ump_fortressZ.bin mp12 Fortress 

Ump_gridZ.bin mp15 Grid 

Ump_setuparea52Z.bin mp3 Area 52 

Ump_setupbaseZ.bin mp1 Base 

Ump_setupcarparkZ.bin mp5 Car Park 

Ump_setupcomplexZ.bin ref Complex 

Ump_setupfelicityZ.bin mp11 Felicity 



Ump_setupg5Z.bin cryp G5 Multi 

Ump_setuppipesZ.bin crad Pipes 

Ump_setupravineZ.bin arec Ravine 

Ump_setupretakinginstituteZ.bin sevb 
Retaking the Institute 
Multi 

Ump_setupruinsbZ.bin mp9 Ruins 

Ump_setupsewersZ.bin mp10 Sewers 

Ump_setupskedarZ.bin oat Skedar Multi 

Ump_setuptempleZ.bin jun Temple 

Ump_setupwarehouseZ.bin mp4 Warehouse 

Ump_villaZ.bin mp13 Villa Multi 

UsetupairbaseZ.bin cave Air Base 

UsetupairforceoneZ.bin rit Air Force One 

UsetupattackshipZ.bin lee Attack Ship 

UsetupchicagoZ.bin pete Chicago 

UsetupcitrainingZ.bin dish CI Training 

UsetupcrashsiteZ.bin azt Crash Site 

UsetupdeepseaZ.bin pam Deep Sea 

UsetupdefectionZ.bin ame Defection 

UsetupdefenseZ.bin imp 
Carrington Institute 
Defense 

UsetupduelZ.bin ate Duel 

UsetupescapeZ.bin tra Escape 

UsetupextractionZ.bin ark Extraction 

Usetupg5buildingZ.bin depo G5 Building 

UsetupinfiltrationZ.bin lue Infiltration 

UsetupinvestigationZ.bin ear Investigation 

UsetupmaiansosZ.bin sev Maian SOS 

UsetupmrblondeZ.bin wax Mr. Blonde's Revenge 

Usetuppelagic2Z.bin dam Pelagic 2 

UsetuprescueZ.bin lip Rescue 

UsetupretakinginstituteZ.bin sevb Retaking the Institute 

UsetupskedarruinsZ.bin sho Skedar Ruins 

UsetupskedarZ.bin oat Skedar 

UsetupvillaZ.bin eld Villa 

UsetupwarZ.bin stat War 

 

iii. Edit Setup -> Visual Editor 

1. Note that the level is currently another level, and not yours yet, that’s 

normal. 

4) Adding Textures to ROM and Obj Conversion 

 



After your level is completed, before doing any work, the first step is adding textures to ROM 

and converting the background file. 

 

i. Create a text file listing the new bitmaps used by the level that need to be 

imported, one bitmap filename per line.  Remember that spaces are not allowed 

in textures, and no paths can be present. 

 

Do not include any textures you are reusing from GoldenEye or Perfect Dark 

(that have the original bmp names). 

 

A simple way at the windows command prompt is to, in the directory you are 

using for the project, to create the file using the command prompt: 

C:\GoldeneyeStuff\GE Editor Source\Tutorial>dir *.bmp /b > textures.txt 

 

This will create a file called textures.txt which can be used.  Ensure all 

GoldenEye (or for Perfect Dark if Perfect Dark level) original textures are 

removed from this file.   If your textures are from GoldenEye but level is in PD, 

the textures must be specified since won’t be in ROM, or vice versa. 

   Example (textures.txt): 

73BTransparent.bmp 

carpet_blue.bmp 

corridor_wall.bmp 

glass_alpha.bmp 

holodeck.bmp 

lights.bmp 

R31Transparent.bmp 

room_wall.bmp 

water_alpha.bmp 

 

GoldenEye has much more space for new textures than Perfect Dark due to 

auto-extending the ROM if need be.  For Perfect Dark, if you get a “Trying to add 

too many textures error”, go to the 39850 editor (Tools -> 21990 (GE) / 39850 

(PD)), click Delete Debug Data (and J text), then write ROM with 3050/39850 

Mods.  Use this shrunk ROM instead of the normal PD 1.1 ROM and there 

should be more room for textures. 

 

ii. Convert the .obj file to GE Level (and add textures file). 

1. In the Visual Editor window, Convert -> Convert the .obj file to GE Level 

(and add textures file) 



2. Pick your textures.txt file generated above.  If you have no textures to 

add (all original GoldenEye or Perfect Dark) textures, just cancel the first 

textures.txt prompt and you will not need to specify a file. 

3. Choose a clean GoldenEye (or Perfect Dark ROM) 

4. Choose an output ROM (and remember the name) and hit OK 

If any errors occur, you must cancel out from converting the .obj file and 

correct them, then redo the process.  Common errors are a space in 

filename, too big width/height (over 32 x 64), not 8-bit 256 color 

bitmap. 

5. If successful, a file with the filename [textures.txt]MultiAddNumbers.txt 

will be created.  This is a mapping of bitmap name to image digit, and 

looks like, and used for reimporting the obj file without reimporting 

textures: 

 

0A8A 73BTransparent.bmp 

0A8B carpet_blue.bmp 

0A8C corridor_wall.bmp 

0A8D glass_alpha.bmp 

0A8E holodeck.bmp 

0A8F lights.bmp 

0A90 R31Transparent.bmp 

0A91 room_wall.bmp 

0A92 water_alpha.bmp 

6. If textures were already imported, you can use the file generated in step 

5 (the MultiAddNumbers.txt) and import instead using Convert -> 

Convert Obj to GE Level (if already imported textures) and pick this file 

instead. 

7. Now pick the .obj file for your background and hit OK.  There are various 

errors that can occur: 

 

Cannot find .mtl file: Material file not in folder or specified wrong in obj 

file (maybe has path?) 

Too big u,vs: There is some auto-correction of this, so this error can be 

ignored, unless textures look stretched.  If so, you will need to fix these 

in your model, as the u,vs are too large as the games have a limited size 

allowable.  This can in most cases, be ignored. 

Too big coordinates: Your level is too large, consider using scaling in 

GoldenEye, or simply shrinking something in the background as the level 

won’t work. 

Too many vertices: Too many vertices in a room, need to split up rooms 

Cannot find texture: Texture not found, maybe it didn’t import right, or 

is not present 



8. Many temporary files are spit out, and your rooms have been converted 

to GoldenEye format, but have not been compiled.  Both GoldenEye and 

Perfect Dark share a common format (GoldenEye’s) for the editors 

purposes, but are compiled for the particular game when exporting.   

 

A file called RoomPositions.txt has been generated automatically.  This 

contains a mapping of room center (automatically calculated in this 

instance), and the automatically generated room files.   

 

These can be made manually.  The format is one line per room, tab 

separated, spaces not allowed in filenames: 

XCenter (Hex float) YCenter (Hex float) ZCenter (Hex float)

 Vertices.bin file Primary Indices.bin Secondary Indices.bin 

Room 00 must always be centered at 0,0,0 and contain null.bin files and 

must be specified.  Use null.bin for any file not used, usually for not 

containing secondaries (null.bin means ignored by editor).  The file is 

terminated by an @ sign on a line. 

 

Example from Tutorial: 

00000000 00000000 00000000 null.bin null.bin null.bin 

 

4467C000 431C0000 C52DA000 RoomVertices01.bin RoomIndices01.bin null.bin 

44DAE000 43600000 C5784000 RoomVertices02.bin RoomIndices02.bin null.bin 

45532000 434C0000 C4974000 RoomVertices03.bin RoomIndices03.bin null.bin 

45896800 43720000 C53FF000 RoomVertices04.bin RoomIndices04.bin

 RoomIndices204.bin 

44982000 43600000 C490C000 RoomVertices05.bin RoomIndices05.bin null.bin 

4552E000 43420000 C5795000 RoomVertices06.bin RoomIndices06.bin null.bin 

@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@

@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@ 

iii. Prepare the preexisting level for import 

1. Delete all Portals 

Switch mode to Edit Portals/BG, then right click and choose Delete All 

Portals 

2. Delete all Clipping 

Switch mode to Edit Clipping, then right click and choose Delete All 

Clipping 

3. Delete all Visibility Data 



Some levels use extra visibility data.  Switch mode to Edit Portals, then 

right click and choose Open Visibility Editor.  Click Clear Visibility, then 

click Update Visual Editor. 

 

4. Delete all Lighting (Perfect Dark only) 

Switch mode to Edit Lighting, then right click and choose Delete All 

Lighting 

 

If Portals, Clipping, Visibility, and Lighting are not deleted, there is the 

possibility the editor will crash while importing, and if it doesn’t, it will 

crash in-game. 

 

5. Export the background file.  Switch mode to Edit Room Positions.  Right 

click and choose Export Background File.  Pick the Room Positions file, 

then call the output bgfile.bin.  Hit OK.  The level should now have new 

architecture, and will have incorrect textures. Do not panic.   

6. Save Project.  Project mode saves in a combined fashion, a level choice 

(ie. Runway being edited), setup file, pads file (Perfect Dark Only), 

background file, and clipping file.   

 

File->Save as Project, then type in the name you want for the project.  

GoldenEye and Perfect Dark projects must all be unique, so no name 

can be shared (will overwrite your other project if has same name).  

Only the correct games projects will be shown in case resaving over an 

existing project, however.  Then click Save as Project.  Choose the 

project folder to save the data to and hit OK.  Now pick the ROM we 

added textures to, to use as a base and hit OK.  Save as Project + Rooms 

reexports the existing rooms, and should only be used when changing 

lighting, moving/rotating rooms, or rgb changes to vertices, etc, and 

need the level reexported.  Save as Project without the + 

rooms will not maintain any room changes otherwise and will just use 

the bgfile.bin previously exported or imported.  The data about your 

project is saved in the levelmacros.ini file along with the editor, and can 

be edited manually if need be to adjust things. 

7. Close the Visual Window 

8. Open Project.  File -> Open Project, then choose the project saved 

before.  The level will now show textures.  You can also choose under 

Convert menu, Convert -> Load Images from ROM and pick the new 

ROM. 

9. Repeat the above process in order to reexport the level. If you opened 

your project already and do not have texture changes, you will not need 

to close and reopen the project as the textures are already there.   



10. Test to make sure background file/textures are fine 

 

Go to Edit Room Positions mode.  Create one clipping tile in Room 

Positions mode where you can walk. Do this by right clicking and choose 

Convert to Clipping -> Convert Triangle to Clipping Tile.  If you click 

Clipping Off to change it to Clipping On, you should see your clipping 

triangle.  You can also select a triangle and press the F key to convert it 

to clipping. 

 

Go to Edit Objects Mode, right click above the clipping spot, and choose 

Insert Preset. Then right click on blue preset created, and choose Set as 

Solo Start Point.  It should turn grey.  Then click right click and choose 

Delete all Unused Presets. 

 

Now File->Save as Project again with same details. 

11. Test ROM 

 

Perfect Dark has some issue with textures that has not currently been 

solved.  It appears to be related to the assembly instruction changes 

made to add more textures.  If your ROM will not boot, you should 

rearrange your textures.txt file (order of it), and try again.  Keep going 

until it boots.  You will need to redo your convert obj steps again after 

this, so it is wise to test this before performing obj conversion (that 

ROM boots).  GoldenEye does not suffer from this. 

 

Inject the Project.  File->Inject Project into ROM.  Choose your project, 

then click Inject Project into ROM.  Choose a ROM to save as, for your 

testing.  It can be the same ROM as input ROM. 

 

Test it! If it fails, check your textures, they may be too large (bigger than 

32 x 64 or an odd dimension).  You can try the ROM without textures 

(just cancel the textures.txt prompt), to see if maybe its texture related.  

Did you forget to delete all portals or clipping before exporting 

background file? 

 

Occasionally tris will be facing the wrong direction in primary, and since 

primary draws only show from one direction, sometimes tris will need 

to be flipped in the model file.  You can see direction in the editor by 

pressing Control U (again to turn off) to show the direction of normals.  

You can right click on the triangle and choose Flip Tri to swap direction, 

and be sure to Save as Project + Rooms to keep that change. 

 



iv. RGB/UV changes on a Triangle 

 

In Room Positions mode, right click on a triangle and choose Open Vertice Color 

Dialog.  Here coordinates, as well as RGB, and U,Vs can be edited.  When done, 

choose OK. The … button will open a color picker. 

 

Copy and Paste Tri Color right click options (or Control-Alt-LClick and Alt-LClick) 

to copy and paste colors. 

 

A spherical “lighting source” can be set to light the level.  Right click on the point 

to start the lighting source, then choose Set Lighting Source.  The range in the 

dialog box is the radius of the lighting, then the start and end intensities. 

 

When done with all changes, be sure to Save as Project + Rooms to keep that 

change, and use the outRoomPositions.txt for all future exports.   

 

 

5) Clipping 

 

The next step is to clip the level.   

If you imported clipping from obj file, you can skip this step except to tweak your level.   

You may want to right click and choose Toggle Room Changes allowed so you don’t accidentally 

move a background. Control H (and H to reverse) also perform the same holding of rooms.  

Go to room positions mode.  Clicking Clipping Off to change it to Clipping On to see clipping.  To 

clip a single triangle, click the triangle with the mouse, and press F to create clipping there.   

Right clicking in room positions mode also gives option such as Clip All Tris, Clip all Vertical Tris, 

and Convert to Clipping->  Selected Room Floor, All Tris in Room, as well as at the RG, GB, and 

RB connections for selected background triangle. 

Switch to Edit Clipping Mode when done.   

Press Control H to not accidentally move clipping tiles (H reverses it).   Also, undo is supported 

for clipping, by Control-Z, and Control-Y for Redo.  You can also select multiple tiles by holding 

shift while selecting or control and clicking.   

To delete a clipping tile, click the triangle and press delete key.  

Clipping colors can be changing by selecting one or more tiles, and right clicking, then choosing 

Color and editing R, G, or B.  



Clipping positions can be manually edited by right clicking a tile, and choosing Open Tile Dialog.  

The Tile Dialog will change the selected triangle based on the comboboxes, and let you edit the 

coordinates manually. The little triangles at the vertices of the clipping triangle are not drawn, 

but used to show the order of points.   A little red triangle indicates point 0, green triangle 

indicates points 1, and blue point 2.  All triangles must be counterclockwise, but the editor will 

handle that automatically.   

Rooms should be the same as background, and should be automatically set to right room when 

generating, but if not, right clicking and choosing Change Room, can change the room number. 

 

i. GoldenEye specific 

 

All floors must be clipped (areas where you can walk), as well as stairwells, and ladders.   

Areas where you do not want to walk should not be clipped, as you will be blocked from 

walking there.   

 

To make tiles Kneel, Ladder, or Normal, right click on tiles and choose Change Type.  

Standard clipping tiles uses the color set for the tile, while Kneel is yellow, ladder is blue, 

and ladder + kneel is purple. 

 

Clipping works by each tile connecting to its identically touching neighbors.  Also, all 

triangles must identically touch, and cannot have edges of different sizes.  Luckily the 

editor can take care of most of these post-import.  After import, Right click and choose 

Stan Convert – this fixes the tris so they all identically touch.   

 

Next, click Redo Clipping Connections to fix the connections.  You’ll see the connections 

when clicking a triangle, by seeing the Red, Green, and Blue connections.  If they do not 

identically touch, they will not be connected and in-game you will not be able to pass 

from one to the other, and must fix this.  You can manually edit the coordinates in the 

Open Tile Dialog for that clipping triangle, then Redo Clipping Connections again.   

Connections can be manually made by right clicking, but this is not recommended in 

most cases, and can only really be used well for situations like one-way connections, 

which is not covered here. 

 

As a special note, whenever changing clipping, click Relink all Tile PLinks so that objects 

and presets pick up the new clipping.  If not relinked, there could be some issues in that 

objects think they are above the wrong clipping tile.  If no presets were relinked, it just 

means they all have the right clipping tile match.   

 

ii. Perfect Dark specific 

 



All floors and walls must be clipped, as well as stairwells, and ladders.  The floors are 

where you can walk, while the walls block you from walking.  If walls are not present 

when you leave a floor tile, if there is no more floor tile you will fall to your death.  To 

set a Tile as Walkable, right click and choose Set Tile as Walkable, and it will turn yellow.  

To make it a wall, right click and Choose Set Tile as Wall, and it will turn a transparent 

red.  Unset/Set tile flags can also be used, unset Block AI Fire for walls to let 

guards/simulants shoot through the wall (used for railings), and wall will turn blue.   

 

To make a triangle Kneel, Crouch, or Normal, right click on tiles and choose Change AI 

Type.  The Sound Effect of stepping on the tile can be changing by right clicking on tiles 

and choosing Change Sound Effect.   

 

Since vertical tiles must block all movement and not all walls are architecture, you can 

right click on a triangle, and choose Add Vertical Clipping, then using the little red, 

green, and blue little triangles at vertices choose the edge you want to add one at, then 

pick the height. 

 

In Tools -> Preferences, under Visual Editor tab, can choose to View Clipping as 

Walkability.  If unchecked, it views similar by clipping color. 

6) Portals 

Portals connect two rooms.  Click Portals Off to turn Portals On and shown.  You can right click 

and choose Select Portal to pick a portal.  After right clicking on a particular portal, you can 

change the two rooms connected.  Right clicking on a spot can also insert a portal for 

manipulation. 

There is an auto-portal feature which adds a vertical portal between all directly connected and 

clipped room intersections.  They will need to be tweaked to change the height after auto-

portalled and likely some deleted/added. 

When done, reexport the background file with the latest version of 

RoomPositions.txt/outRoomPositions.txt, otherwise the changes will not be used. 

 

7) Visibility 

 

Visibility is used when portals cannot adequately be used to connect two rooms, but perform a 

similar function.   

 

To connect a room, choose the room, then next to the Add Room button, choose the connecting 

room, then click Add Room.  The right textbox shows a summary of how the rooms are 

connected.   

 



To delete a connection, choose the start room, then next to Remove Room button, choose the 

connecting room, then click Remove Room.  It will say Added in the combobox if can be deleted.  

The right textbox shows a summary of how the rooms are connected.   

 

When done, click Update Visual Editor, otherwise the changes will not be used, then reexport 

the background file with the latest version of RoomPositions.txt/outRoomPositions.txt. 

 

8) Lighting (Perfect Dark only) 

 

Click L Off to change it to L On to show lighting.  Switch to Edit Lighting Mode.  

 

Lighting is not fully supported, but a particular lighting can be selected.  Cloning lighting is 

probably the easiest and only way to add lighting, then right click on new one after moving and 

change the Room number, or exporting to lighting file and reimporting. 

 

Color can be changed by right click and changing Edit Properties, then changing RGBA color in 

hex. 

 

When done, reexport the background file with the latest version of 

RoomPositions.txt/outRoomPositions.txt, otherwise the changes will not be used. 

 

9) Setup File 

 

Not covered here, other tutorials will cover this, but complete your setup file. 

 

10) Project Basics 

 

Mainly covered before, but to clarify 

i. Save as Project 

 

Uses the last loaded background file (does not reexport), then reexports clipping 

and setup (and pads file for Perfect Dark). 

 

ii. Save as Project + Rooms 

 

Reexports the background file using RGB/UV changes in editor, then reexports 

clipping and setup (and pads file for Perfect Dark). 

 

iii. Open Project 

Open a previously created project. 

 

iv. Inject Project 



Inject bgfile, setup (and pads for Perfect Dark), and clipping into the base ROM 

used for textures, then saves to a new ROM. 

 

11) Image Editor 

The Image Editor allows you to view the textures inside a ROM for both GoldenEye and Perfect 

Dark.  New textures can be imported over old ones. 

 

Tools->Image Editor.  The default ROM loaded is the quick ROM, change it by clicking Choose 

ROM.   

 

Mainly for new level purposes, it can be used to ensure that the new textures are incorporated 

correctly, or to replace one after the fact.  

 

One important aspect that the Image Editor can do is change in GoldenEye the hit type of the 

texture by right clicking on the texture, while Perfect Dark can change the sound effect and 

bullethole independently.  To replace a custom texture, right click and choose Replace Image. 

Greyscale can be replaced, but cannot be used for custom levels.  When done with all changes, 

click Write New ROM with Changes. 

 

 

12) Checklist when level doesn’t load 

 Back up all your data 

 Start over 

 Add textures to ROM 

 Load ROM, ensure ROM works (issue is textures in ROM) 

 Convert obj to bgfile using the textures file 

 File -> New for setup file 

 Delete all Portals 

 Delete all Clipping 

 Delete all Visibility 

 Delete all Lighting (Perfect Dark Only) 

 Export bgfile 

 Make one clipping tile on floor 

 Make one preset/pad and make it a start point over the clipping tile 

 Load ROM, ensure level works (issue is bgfile or textures).  If you die immediately in PD 

as it loads, raise up the start point pad to above the clipping and try again. 

 Reimport clipping 

 Load ROM, ensure level works (issue is clipping) 

 Reopen setup file 

 Load ROM, ensure level works (issue is clipping) 

 If fails, there are many issues that can occur but here’s a Standard procedure to figure 

out what 



i. Delete all action blocks and test (infinite loop? Click check syntax and go 

through blocks) 

ii. Delete all objectives and test (is a text in briefing is wrong level’s digit – does it 

crash before loading level, in briefing?) 

iii. Delete objects, group at a time (which ones wrong) 

iv. If still wrong, may be a bad pad/preset  


